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This manual includes instructions for the Watershed Prioritization Tool, the Crossing Replacement Tool, 
and several data editing tools contained within CADSS.  For additional information contact Craig Roghair, 
croghair@fs.fed.us, 540 231-0078. 
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CADSS Information 

The crossing assessment decision support system (CADSS) is a suite of tools developed to assist 
managers with prioritization of road-stream crossing replacements.  Currently there are two 
prioritization tools: the Watershed Prioritization Tool (WPT) and the Crossing Replacement Tool (CRT).  
The tools use geographic, physical, and biological data in combination with user-defined criteria to 
develop a list of high priority hydrologic units and a list of high priority crossing replacements.  Several 
other tools are included to assist with data editing tasks. 

CADSS was developed through a partnership between the Forest Service Southern Research Station and 
the Virginia Tech Conservation Management Institute.  The most recent release was developed as an 
add-in for ArcMap10, service pack 2.  CADSS has been successfully used with service packs 1, 2, and 3.  

The CADSS add-in installation file is available by contacting Craig Roghair croghair@fs.fed.us 

mailto:croghair@fs.fed.us
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Installing CADSS 

Before installation 
Before installing, check ArcMap to see if a previous version of CADSS is already installed. In ArcMap10 
select Customize > Add-In Manager.   

 

If CADSS appears in the Add-In Manager make sure it is the most current version; if not click Delete this 
Add-In.   

If CADSS does not appear in the Add-In Manager then it is not installed. 

Proceed with installation only after you confirm CADSS is not currently installed. 
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Installation 
The CADSS installation disk contains 3 files:  

 

CADSS10_2011.gdb is the geodatabase that contains data to run CADSS. 

CADSS10_2011.mxd is the map document that displays CADSS data. 

CADSS10Controls.esriAddIn is the file used to install the CADSS tool in Arc10. 

 

Keep a backup copy of the CADSS10_2011.gdb file and the CADSS10_2011.mxd file. The tools in CADSS 
can change values within the geodatabase, so if you want to be able to restore your original data after 
testing the tools, be sure to keep the original installation disk, or create a backup. 

 

Copy all 3 files to a local directory. 

 

Double-click the CADSS10Controls.esriAddIn to begin the installation utility. 
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Click Install Add-In –  

 

NOTE: you do NOT need to have admin rights (self-promote) to install 

 

 

  



Installation 

Page 5 of 48 
 

To confirm installation, start ArcMap10, then select Customize > Add-In Manager 

If installation was successful CADSS will appear in the My Add-Ins section. 

 

You must activate CADSS prior to use.  Click Customize > Extensions, and check mark CADSS 10. 
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To view the CADSS toolbar, select Customize > Toolbars > CADSS Main 

To view the CADSS tools available, click the dropdown arrow at the right of the menu bar 

To run a tool, click on its name in the drop-down menu.   

Refer to the appropriate sections in this manual for detailed use instructions. 

 

 

 

 

Exiting CADSS 
To close CADSS, simply close ArcMap as normal. 

DO NOT save changes to the CADSS10_2011.mxd file 
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Watershed Prioritization Tool (WPT) 

The WPT is used to prioritize among hydrologic units, typically HUCs, within a particular analysis area. 

Before starting the WPT, open CADSS10_2011.mxd; select File, Open, then browse to the file 

To run the WPT, select Watershed Prioritization Tool from the CADSS dropdown menu. 

 

 

  



Watershed Prioritization Tool 

Page 8 of 48 
 

Analysis Area 
The Analysis Area form shows the default hydrologic unit layer that is used by CADSS.  You can analyze 
all hydrologic units (default), or customize the analysis area by selecting specific units for analysis.  

Don’t forget to input a unique name for your output feature class at the bottom of the form. 

 

 
 
 

Choosing specific units is a good way to shorten the analysis run time.  To select specific analysis units 
click either the Choose watershed units using field values radio button, or the Advanced Selection link. 
See next page for details.  
 

  

CADSS will create a feature 
class with this name to store 
results.  It will be displayed in 
the map when analysis is 
complete. 
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Select individual analysis units by name or number using the dropdown menus 

 
 

Select multiple analysis units by clicking the Advanced Selection link to open the SQL Query window 

 
 
Once you have made your selections, navigate to the next form using the Next button. To return to this 
form use the Back button.  

Click Advanced Selection to 
select multiple units.  This 
example code will select all 
HUCs starting with 102902. 
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Impassable Crossing Density 
The Impassable Crossing Density form asks how important it is to consider crossing density when 
prioritizing analysis units. 

Options range from ‘Extremely’ important to ‘No opinion’.  Impassable crossing density must be 
included in the analysis, so ‘Not at all’ is not available as an option. The category weight (red numbers in 
upper right) will change as you select different values. 

You may indicate whether you would like to prioritize for units with either high or low crossing density. 

CADSS comes with default layers, but you may select other layers as needed. 

You may choose to designate crossing status based on a field value (default), or to include all crossings 
as impassable. 

If you wish to choose impassable crossings using a field value then you must indicate which field 
contains the values, and then what values should be considered as impassable.  These fields are pre-
populated if you use the default layers. 

In the example below we are using Filter A results, and telling CADSS to consider impassable, 
indeterminate, and unsurveyed crossings as impassable when running the analysis. 
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Land Ownership 
The Land Ownership form asks how important it is to consider Forest Service management when 
prioritizing analysis units. 

Options range from ‘Extremely’ important to ‘Not at all’.  Selecting ‘Not at all’ will set the category 
weight (red numbers in upper right) to zero and remove this category from the analysis. 

You may indicate whether you would like to prioritize for units with either high or low FS management. 

CADSS comes with a default layer, but you may select other layers as needed. 

You may choose to designate ownership based on a field value (default), or to include all areas as FS 
owned. 

If you wish to choose ownership using a field value then you must indicate which field contains the 
values, and then what values should be considered as impassable.  These fields are pre-populated if you 
use the default layer. 

In the example below we are using a field labeled ORGANIZATI, with a value of USDA FOREST SERVICE to 
select FS managed lands from the Twain_Ownership layer. 
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Fish Presence 
The Fish Presence form asks how important it is to consider the presence of a particular fish species 
when prioritizing analysis units. 

Options range from ‘Extremely’ important to ‘Not at all’.  Selecting ‘Not at all’ will set the category 
weight (red numbers in upper right) to zero and remove this category from the analysis. 

You may prioritize for units that either do or do not contain the species. 

CADSS comes with a default layer, but you may select other layers as needed. 

You may choose to target a particular species (default), or to include all records from the species layer. 

If you wish to select a target species you must indicate which field contains the species list, and select a 
species from the list. 

In the example below we are selecting AMERICAN EEL from a field labeled COMMON in the 
MDC_FishCollections layer.  American eel will be set as the target species.  To set multiple target 
species you must use the Advanced Selection link (see next page). 
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Advanced Selection 
Clicking the Advanced Selection link will open the SQL Query window.  You may select multiple species 
using custom SQL statements.  In the example below we are selecting analysis units that contain bluegill, 
stoneroller, or American eels.  Analysis units that contain all 3 species will be ranked higher than those 
with 0, 1, or 2 of the species.  

 
 

The use of ‘OR’ is required because of the structure of the MDC datasets.  Do not use ‘AND’ when 
selecting multiple species.  Use of ‘AND’ will result in Features to evaluate = 0, as in example below. 

 

Features to evaluate is greater than 0 when your query is structured properly, as in example below. 
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Mussel Presence 
The Mussel Presence form asks how important it is to consider the presence of a particular mussel 
species when prioritizing analysis units. 

Options range from ‘Extremely’ important to ‘Not at all’.  Selecting ‘Not at all’ will set the category 
weight (red numbers in upper right) to zero and remove this category from the analysis. 

You may prioritize for units that either do or do not contain the species. 

CADSS comes with a default layer, but you may select other layers as needed. 

You may choose to target a particular species (default), or to include all records from the species layer. 

If you wish to select a target species you must indicate which field contains the species list, and select a 
species from the list. 

In the example below we are selecting Ouachita kidneyshell from a field labeled NAME in the 
MDC_MusselCollections layer.  Ouachita kidneyshell will be set as the target species.  To set multiple 
target species you must use the Advanced Selection link (see page 13). 
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Natural Heritage Presence 
The Natural Heritage Presence form asks how important it is to consider the presence of a particular 
species from the Natural Heritage database when prioritizing analysis units. 

Options range from ‘Extremely’ important to ‘Not at all’.  Selecting ‘Not at all’ will set the category 
weight (red numbers in upper right) to zero and remove this category from the analysis. 

You may prioritize for units that either do or do not contain the species. 

CADSS comes with a default layer, but you may select other layers as needed. 

You may choose to target a particular species (default), or to include all records from the species layer. 

If you wish to select a target species you must indicate which field contains the species list, and select a 
species from the list. 

In the example below we are selecting E from a field labeled FEDSTAT in the NaturalHeritageClip layer.  
Species with FEDSTAT = E will be set as the target.  To set multiple target species you must use the 
Advanced Selection link (see page 13). 
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Species Richness 
The Species Richness form asks how important it is to consider the number of species present when 
prioritizing analysis units. 

Options range from ‘Extremely’ important to ‘Not at all’.  Selecting ‘Not at all’ will set the category 
weight (red numbers in upper right) to zero and remove this category from the analysis. 

You may prioritize for units that have either high or low species richness. 

Richness is calculated as the sum of unique species present from selected datasets.  Options include 
MDC Fish, MDC Mussels, and the Natural Heritage Database.  You may select  any combination of the 3 
datasets.  CADSS comes with a default layers, but you may select other layers as needed. 

For each dataset selected you must indicate the field that contains the species list. These fields are pre-
populated if you use the default layers. 

In the example below we are using the SCINAME field from MDC_FishCollections  and the SPSCI field 
from MDC_MusselCollections to calculate species richness.  To target specific species within a particular 
dataset you must use the Advanced Selection link (see page 13). 
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Summary 
The Summary form allows you to review and modify your selections.  To accept your settings and run 
the analysis, click the Calculate button. 

 
 

If you get this warning message then you must change your output layer name or CADSS will overwrite 
existing output files. Click ‘Cancel’ to change your output file name.
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WPT Output 
Be patient while CADSS calculates… it may take several minutes depending on analysis area size. 

 

 
 

CADSS will alert you when the analysis is complete, click ‘OK’ to view a table of top results. Note the 
addition of your feature class to the map. 

 

  

A feature class containing the 
analysis results is added to the 
table of contents.  This is 
available even after the top 10 
priority table is closed (see next 
page). 
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The table in the pop-up window shows the top 10 priority HUCs based on your input.  The ‘Sum of 
Weighted Scores’ column is what CADSS uses to rank the HUCs.  Hover your mouse-pointer over a field 
in the ‘Sum of Weighted Scores’ column to see how the score is calculated (shown in red at top of table).  
Raw, scaled, and weighted scores are also available in the table, just scroll to the right.   

Click on a record in the table to select it on the map.  Use the Zoom button to zoom to the map feature. 

This table is no longer available for viewing once closed, but ranks and scores are all saved for future 
reference in the geodatabase associated with CADSS (see next page). 
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To view results after the top 10 table is closed, right click on your output feature class in the table of 
contents window, then open the attribute table.  

 
 

The attribute table contains all data used to generate the final rankings.  The sum of weighted scores 
and priority rank fields are near the end of the table – scroll to the right to view them. 

 

If the feature class is not available in the table of contents, click the Add Data button and browse to the 
geodatabase associated with CADSS, then select your feature class (see next page).  

Right-click, then open attribute 
table. 
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Your output feature class is saved in the CADSS_MO_2011.gdb geodatabase, and is available for future 
use, unless you overwrite or delete it.  To add a feature class from a previous CADSS run, simply click the 
add data button and browse to the feature class within the geodatabase. 
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It is easy to forget what settings you selected within CADSS.  The selections you made to generate a 
particular output file can be viewed within the metadata:  

 Right-click on your output file in the table of contents, then select Data > View Item Description. All 
CADSS settings are listed in the Description section. 
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Crossing Replacement Tool (CRT) 

The CRT is used to prioritize replacements within a designated analysis area, typically a single HUC. 

Before starting the CRT, open CADSS10_2011.mxd; select File >Open, then browse to the file. 

To run the CRT, select Crossing Replacement Tool from the CADSS dropdown menu. 
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Analysis Unit 
The Analysis Unit form allows you to designate your hydrologic units layer and select a single analysis 
unit by name, number, or other designation.  

CADSS comes with a default layer, but you may select others, if needed. 

Select the field that contains the list of hydrologic units, then select the unit of interest.  In the example 
below we are selecting the Anderson Creek-Big Piney River unit from the HU_12_Name field in the 
CADSS_HU12_2011 layer. 

 

 

Don’t forget to input a unique name for your output feature class at the bottom of the form. 

Click the Next button at the bottom of the form to move to the next form. 
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Note that unit names are not necessarily unique. Selecting a name that is a duplicate will cause CADSS to 
generate a warning.   

 

 

If your intention is to run the analysis within a single unit you must re-select using a unique identifier.  

For example, if you select a HUC named Brushy Creek and the above warning is generated you could re-
select by HUC number to run the analysis on a single HUC. 
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Impassable Crossings 
The Impassable Crossings form allows you to designate crossings and streams layers.   

CADSS comes with default layers, but you may select others, if needed. 

The form also asks if you have modified the survey status for any crossings.  If you have updated passage 
status, or if you are uncertain of what passage status field is being applied (e.g. Filter A, Filter B, or Filter 
C) to your analysis you should click Yes. 

It is very important to know the correct passage status field is selected and that values have been 
applied to the network weight field.  CADSS uses values in the network weight field when running the 
CRT. The only way to be certain is to check yes and then run an update (see next page for details), or to 
use the Crossing Weight Editing Tool (see Data Editing Tools section). 

The form also asks if you have permanent barriers you would like to include in the analysis.  Select Yes to 
include a barrier dataset (see page 28 for details). 
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Updating survey status 
There are four primary reasons you may need to update survey status: 

1) You are running CADSS for the first time 
2) You do not know what source field (e.g. FilterA vs. FilterB) is currently loaded 
3) You would like to change the source field (e.g. switch from FilterA to FilterB) 
4) You have changed the passage status of a crossing since last running CADSS 

In any of these cases you should select Yes, select the appropriate source data, then click Update. 

In the example below we are updating survey status using the values in the CATT_FilterB field. 

 

 

Be patient, the conversion may take a couple of minutes.  CADSS provides confirmation of the update as 
shown below.  
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Adding barriers 
If you wish to include natural barriers or dams in the analysis, then you must answer YES to the question 
‘Do you have permanent barriers (natural or artificial)?’ 

Answering yes will allow you to designate a feature class containing barriers.  There is a default layer 
loaded, and you may add features to this layer either manually or with the Barrier Editing Tool in the 
CADSS dropdown menu. 
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Land Ownership 
The Land Ownership form asks how important it is to consider Forest Service management status when 
prioritizing replacements. 

Options range from ‘Extremely’ important to ‘Not at all’.  Selecting ‘Not at all’ will set the category 
weight (red numbers in upper right) to zero and remove this category from the analysis. 

CADSS comes with a default layer, but you may select other layers as needed. 

You may choose to designate ownership based on a field value (default), or to include all areas as FS 
managed. 

If you wish to choose ownership using a field value then you must indicate which field contains the 
values, and then what values should be considered FS owned.  These fields are pre-populated if you use 
the default layers. 

In the example below we are selecting lands listed as USDA FOREST SERVICE from the ORGANIZATI field 
in the Twain_Ownership layer. 

 

  



Crossing Replacement Tool 

Page 30 of 48 
 

Stream Length 
The Stream Length form asks how important it is to consider the length of stream miles opened when 
prioritizing replacements. 

Options range from ‘Extremely’ important to ‘No opinion’.  Stream length must be included in the 
analysis, so ‘Not at all’ is not available as an option. The category weight (red numbers in upper right) 
will change as you select different values. 

The hyperlink on the page takes you to a help document that explains how we calculate the stream 
length metric.  In short, CADSS calculates not the total length of the newly connected reach, but how 
similar in length the two connected reaches are.  CADSS gives the highest score to reaches that are 
similar and length and have high total miles connected.  The table below is a simplified example: 

Upstream reach (miles) Downstream reach (miles) Total reach Rank 
50 50 100 1 
25 25 50 2 
10 90 100 3 
99 1 100 4 
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Stream Connectivity 
The Stream Connectivity form asks how important it is to maximize contiguous stream miles when 
prioritizing replacements.   

Options range from ‘Extremely’ important to ‘Not at all’.  Selecting ‘Not at all’ will set the category 
weight (red numbers in upper right) to zero and remove this category from the analysis. 

Connectivity comes into play only when replacing multiple crossings.  Would you prefer to open stream 
reaches within the analysis unit that are connected to one another, or do you just want to open the 
maximum number of stream miles in the unit regardless of whether they are connected? 

 

 

  



Crossing Replacement Tool 

Page 32 of 48 
 

Budget Constraints 
The Budget Constraints form asks how important it is to consider total costs when prioritizing 
replacements.   

Options range from ‘Extremely’ important to ‘Not at all’.  Selecting ‘Not at all’ will set the category 
weight (red numbers in upper right) to zero and remove this category from the analysis. 

Budget constraints come into play only when replacing multiple crossings.  CADSS assumes that all 
replacements cost the same amount and thus expenses increase as the number of replacements 
increases.  As such, CADSS will always score options with the fewest replacements the highest. 
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Advanced Options 
The Advanced Options form allows you to change several settings, the most important being the 
number of crossings you want to replace.  Processing time increases exponentially as the number of 
crossings considered increases.   

Note the ESTIMATE PROCESSING TIME link – a useful tool for comparing processing time prior to 
running the analysis. 

Ways to decrease processing time: 

• Use the short-hand method 
o  The short-hand method is explained in the help link, but note that we have not tested 

this function thoroughly yet, so use it with caution 
• Designate crossings that must be contained in the results 

o Particularly useful if you know you must replace a particular culvert, but have enough 
funds to replace multiple culverts simultaneously 

Note that all results are stored in a feature class, so you will not need to re-run lengthy analyses. 
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Summary 
The Summary form allows you to review and modify your selections.  To accept your settings and run 
the analysis, click the Calculate button. 

 

 

If you get this warning message then you must change your output layer name or CADSS will overwrite 
existing output files. Click ‘Cancel’ to change your output file name. 
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CRT Output 
Be patient while CADSS calculates… it may take several minutes depending on analysis area size. 

 

 
 

CADSS will alert you when the analysis is complete, click ‘OK’ to view a table of top results. Note the 
addition of two feature classes to the map. 

 

  

Two feature classes containing 
results are added to the table 
of contents.  These are 
available even after the top 10 
priority table is closed (see next 
page). 
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The table in the pop-up window shows the top 10 priority replacements, or replacement combiniations 
based on your input.  The ‘Sum of Weighted Scores’ column is what CADSS uses to rank replacements.  
Hover your mouse-pointer over a field in the ‘Sum of Weighted Scores’ column to see how the score is 
calculated (shown in red at top of table).  Raw, scaled, and weighted scores are also available in the 
table, just scroll to the right.   

Click on a record in the table to select it on the map.  Use the Zoom button to zoom to the crossing 
features. Use the Stream button to view the streams associated with the crossing replacements. 

This table is no longer available for viewing once closed, but ranks and scores are all saved for future 
reference in the geodatabase associated with CADSS (see next page). 

 

 

Selecting rows in the table will highlight the crossings contained.  Click the Streams button to display 
connected stream reaches. 
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Use the Zoom and Stream buttons on the top 10 table to see stream segments connected by removal of 
impassable crossings.  In the example below, two stream segments are connected by the removal of a 
single impassable crossing near the center of the highlighted reach.  
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To view results after the top 10 table is closed, right click on your output feature class in the table of 
contents window, then open the attribute table.  

 
 

The attribute table contains the scores and the final rankings for the top 10 options.  The sum of 
weighted scores and priority rank fields are near front of the table. 

 

If the feature class is not available in the table of contents, click the Add Data button and browse to the 
geodatabase associated with CADSS, then select your feature class (see next page).  

Right-click either crossings or 
streams output layers, then 
open attribute table. 
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Your output feature classes are saved in the CADSS_MO_2011.gdb geodatabase, and are available for 
future use, unless you overwrite or delete them.  To add a feature class from a previous CADSS run, 
simply click the add data button and browse to the feature class within the geodatabase. 
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It is easy to forget what settings you selected within CADSS.  The selections you made to generate a 
particular output file can be viewed within the metadata:  

 Right-click on your output file in the table of contents, then select Data > View Item Description. All 
CADSS settings are listed in the Description section. 
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Data Editing Tools 

CADSS tools are available for several common data editing tasks: 

Task Tool(s) required 
Update the passage status of a crossing, for 
example, change status from unknown to 
passable.  

Survey Status Editing Tool, then 
Crossing Weight Editing Tool 

  
Re-load an updated crossing status field for 
analysis.  For example, you have updated 
passage status for several crossings, and want 
to use the updated status next time you run a 
prioritization tool. 

Crossing Weight Editing Tool 
 

  
Add or remove a permanent barrier (e.g. dam, 
waterfall, etc.) to the stream network.   

Network Barrier Editing Tool, then 
Network Flow Editing Tool 

  
Initialize flow within your stream network 
(required for using the CRT). 

Network Flow Editing Tool 

 

See following pages for detailed instruction on the use of each data editing tool. 

  



Data Editing Tools 

Page 42 of 48 
 

Survey Status Editing 
The Survey Status Editing Tool is used to change the passage status of crossings. 

This tool makes changes to the underlying data that cannot be undone.  Be sure to make a backup copy 
of the CADSS_MO_2011.gdb geodatabase before using this tool. 

Access the tool through the CADSS dropdown menu. 

 

Once the tool opens you can select a crossing layer and a survey status field to edit. 

 

Zoom to the crossing(s) you would like to update, select the crossing(s) with the Arcmap10 
selection tool, then click a stoplight icon (hover over icons to view description) on the right of 
the toolbar to update the crossing status.   CADSS will prompt you to confirm the update.  

  

To apply the updates to your next analysis you must run the Crossing Weight Editing Tool (see 
next page).  
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Crossing Weight Editing 
The Crossing Weight Editing Tool is used to apply the correct passage status field to the network weight 
field. There are four primary reasons you may need to run this tool: 

1) You are running CADSS for the first time 
2) You do not know what source field (e.g. FilterA vs. FilterB) is currently loaded 
3) You would like to change the source field (e.g. switch from FilterA to FilterB) 
4) You have changed the passage status of a crossing since last running CADSS 

It is very important to know the correct passage status field is selected and that values have been 
applied to the network weight field.  CADSS uses values in the network weight field when running the 
CRT.  The only way to be certain that the correct values are being applied is to run this tool, or to use the 
Update button on the Impassable Crossings tab in the CRT (see page 28) 

Access the tool through the CADSS dropdown menu. 

 

 

Select the crossing dataset and the network weight field, then select which survey status field to apply 
to the network weight field.  Click the icon to the right of the survey status dropdown to run the tool. In 
the example below we are assigning network weights to the text values in CATT_FilterA and storing 
them in the Impassable field of the CADSS_Crossings2011 dataset.  The values stored in the Impassable 
field will be used by CADSS when the CRT field is run. 
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Network Barrier Editing 
The Network Barrier Editing Tool is used to edit natural (e.g. waterfalls) or manmade (e.g. dams) barriers 
in a barrier data layer. 

Access the tool through the CADSS dropdown menu. 

 

CADSS comes with a default barrier layer, CADSS_Barriers2011, as shown below. 

 

Select a target barrier layer, a network weight field, and a streams layer to edit.  In the example below 
we are editing a barrier on the CADSS_Streams2011 layer.  
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To add a barrier, click the red button   .  Crosshairs will appear that snap a point to the nearest 
stream.  Move the crosshairs to the desired barrier location and click. 

 

Click Yes to keep the new barrier. 

 

CADSS warns you to run the Flow Editing tool after editing a barrier.  CADSS will not be able to run the 
CRT without first running the Flow Editing tool.  You can run the flow editing tool at any time following 
barrier editing (see next page). 

 

All barriers are added to the network as fully impassable.  You may need to run the Network Flow 
Editing Tool on the streams layer after editing (see next page). 

To remove a barrier, use the select tool to select the barrier, then click the green button . 
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Network Flow Editing 
The Network Flow Editing Tool is used to initialize flow in a stream network.  Flow must be initialized for 
all streams in a network prior to running the Crossing Replacement Tool (CRT). 

If flow is not initialized you will receive the following error after clicking the Calculate button in the CRT. 

 

Access the tool through the CADSS dropdown menu. 

 

Select your target stream network, then click the Set Flow to Digitized Direction button. 

 

Click Yes to accept the changes.  The CRT will now be able to run. 
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